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This manual is available:

• As an HTML website

• As a PDF File: SuperBOL-Studio-User-Manual.pdf

1 Forewords
SuperBOL Studio is an extension for VSCode to develop in COBOL. SuperBOL Studio uses an LSP
(Language Server Protocol) Server to understand COBOL sources, display various information
and help developers navigate in the sources.

SuperBOL Studio was firstly designed by Titagone-OCamlPro to work with the GnuCOBOL free
open-source compiler.
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2 Introduction
Welcome to this user manual. This document will explain how to install, configure and use the
SuperBOL Studio extension for Vscode to edit COBOL application sources.

The SuperBOL Studio extension allows COBOL developers to benefit from a modern IDE experi-
ence to edit their COBOL programs.

Links related with SuperBOL Studio:

• Description on SuperBOL website: https://superbol.eu/solutions/superbol-studio/

• Description on Open-VSX: https://open-vsx.org/extension/OCamlPro/SuperBOL

• Description on Vscode Marketplace: https://marketplace.visualstudio.com/items?itemName=
OCamlPro.SuperBOL

• Sources on Github: https://github.com/ocamlpro/superbol-studio-oss

• Another Documentation: https://ocamlpro.github.io/superbol-studio-oss/sphinx

In this manual, screenshots are often taken in a light color theme, to ease printing this document,
though many users prefer to use VSCode in the default dark theme. A section in the “Using
Vscode” chapter shows how to switch between color themes.

3 Installation
You can install SuperBOL Studio either directly from within VSCode (using the extensions
marketplaces), or via a downloaded VSIX file.

3.1 Installation within VSCode
This is the easiest way to install SuperBOL Studio, directly from within VSCode. With this way,
you will install the official versions of SuperBOL Studio only. Depending on your version of
VSCode, the extensions come either from Microsoft VSCode Marketplace or from the Open-OSX
repository, managed by Eclipse Foundation.

Follow these steps:

1. Click on the “Extensions” icon in the activity bar on the left-hand side, or press Ctrl+Shift+X.
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2. Search for “superbol”
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3. The first items that should appear will be:
• SuperBOL Studio OSS: the extension that you want to install to use SuperBOL Studio
• SuperBOL Studio Pack: an extension that contains the “SuperBOL Studio OSS” extension,

together with other third-party extensions
4. Click on the Install button on one of these two extensions
5. The extension will install itself, and the “Install” button should turn into a configuration wheel

button

You can find further instructions for installing extensions directly within VSCode on this page.

3.2 Installation via a downloaded VSIX file
This is the way to use if you want to install an unofficial version of SuperBOL Studio, typically a
test version with beta features, or a version compiled from the sources on Github.

Follow these steps:

1. Check the location of the extension file on your computer. It should come as a single file with
the .vsix extension

2. In VSCode, go to the the “Extensions” view
3. In the sidebar, click on the three dots (...) on the top right-hand side (just above search),
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4. Select Install from VSIX…, and a dialog box should appear

5. Pick the VSIX file on your disk, and click Install

Note that you can also use this method to install Vsix files downloaded from the marketplaces.
For that, you need to select the correct binary for your platform:
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3.3 SuperBOL Studio OSS vs SuperBOL Studio Pack
The SuperBOL Studio OSS extension contains the SuperBOL Studio basic features. OSS stands
for “Open-Source Software”, as the extension is open-source: most of the sources are publicly
available on Github (allowing to rebuild the .vsix file with public features), and the other sources
are provided to SuperBOL’s customers within the “Subscription” contract.

The SuperBOL Studio Pack extension is a “meta extension”: it selects a set of extensions to be
installed together. This is usually useful if you want to benefit from our choice of some other
extensions that we found useful to use together with SuperBOL Studio OSS.

Currently, SuperBOL Studio Pack includes:

• SuperBOL Studio OSS, of course
• tamasfe.even-better-toml: a mode to edit TOML files, that can typically be used to edit

the superbol.toml file for advanced configuration. See https://marketplace.visualstudio.com/
items?itemName=tamasfe.even-better-toml

3.4 Links to the Extensions Pages
• Descriptions on Open-VSX: https://open-vsx.org/

‣ SuperBOL Studio OSS: https://open-vsx.org/extension/OCamlPro/SuperBOL

‣ SuperBOL Studio Pack: https://open-vsx.org/extension/OCamlPro/SuperBOL-studio-pack

• Descriptions on Vscode Marketplace:

‣ SuperBOL Studio OSS: https://marketplace.visualstudio.com/items?itemName=OCamlPro.
SuperBOL

‣ SuperBOL Studio Pack: https://marketplace.visualstudio.com/items?itemName=OCamlPro.
SuperBOL-studio-pack

• Sources on Github: https://github.com/ocamlpro/superbol-studio-oss

4 Workspace Configuration
SuperBOL Studio can be used both on single COBOL files, or on a full COBOL project, usually
called a Workspace in VSCocde language.

4.1 Editing an Existing Project as a Workspace
To start using the extension on an existing project, open its folder in VS Code (File > Add Folder
to Workspace…).
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The extension will start automatically whenever the folder contains files with usual COBOL
filename extensions (.cob, .cbl, .cpy, .cbx).

Once the extension is started, COBOL sources should appear with colorization:
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The extension will try to parse the sources, and resolve COPY statements. If it fails, it will display
problems:

• the number of problems found after the file name in the file explorer
• these problems are shown directly in the sources

Note that, in our case, we use the “Error Lens” VSCode extension to inline errors in the source
code. There are many similar extensions to improve the visualization of problems.

You can also directly go to the first problem, using Ctrl+Shift+M:
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Such problems usually come from a bad configuration of the workspace for the COBOL dialect
used by this project. So we need to configure it to make the extension work correctly. We will see
this in the next section.

4.2 Configuring the Extension for the COBOL Project
Open the settings (File > Preferences > Settings, or Ctrl+,), and start typing “superbol…”.
You will be presented with a screen that resembles:

Figure 1:  SuperBOL settings
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Beware that there are several ways to configure settings:

• User settings: these are the default settings when the workspace is not configured. On the
picture above, they are on the left tab “User”. They are stored in the user profile, typically in
$HOME/.config/Code/User/settings.json.

• Workspace settings: these are the settings specific to this workspace. They are the ones you
probably want to configure now. On the picture above, they are on the right tab “Workspace”.
They are stored in a file .vscode/settings.json at the root of the workspace.

• Additionnaly, SuperBOL Studio can use its own configuration file for some settings, located in
a file superbol.toml at the root of the project. This file is typically useful if you plan to use
SuperBOL tools on the command-line in this project. VSCode will sometimes warn you if you
are trying to configure settings internally in VSCode when there is also a superbol.toml file.

In our example, the source format was correctly inferred. If it is not your case, you can change
the Source Format option:

• The default reference source-format "superbol.cobol.sourceFormat" When auto is selected,
which is the default, SuperBOL (and GnuCOBOL) will automagically try to guess whether the
source is in free or fixed format. Other source formats need to be configured explicitly.

Figure 2:  SuperBOL settings

In our case, the extension complains about not finding some copybooks. Two settings are available
to control how the extension looks up for copybooks:
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Both options have to be configured in JSON by modifying the settings.json file, so you need to
click on “Edit in settings.json”.

Figure 3:  Editing copybook paths in .vscode/settings.json

• The path to copybooks “superbol.cobol.copybooks”. This is a list, where each entry describes
an element of the search path where your copybooks will be looked for. Each entry must contain
a field “dir”, and an optional field “file-relative”.

‣ If the directory you want to specify (where copybooks are located) is a path starting from the
root of the workspace, or an absolute path, you can skip the file-relative field, or set it
to false.

‣ If the directory you want to specify is a path relative to the directory containing the specific
COBOL source with the COPY statement, you should set the file-relative field to true.

• The copybook extensions “superbol.cobol.copyexts”. To configure this setting, you will need
to select Edit in settings.json. This is a list, where each entry describes a file extension if
the copybook name cannot be found as-is (for example COPY   "mycpy.lib"). In SuperBOL, the
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default option corresponds to GnuCOBOL’s default, which is ["cpy","cbl","cob"] (searched
in upper-case first, and then in lower-case).

Do not forget to save the file (with Ctrl+S). As soon as it is saved, the extension will restart the
LSP to re-analyze the COBOL sources.

Now, the extension gives us a different kind of errors, because it couldn’t understand the syntax:

• The COBOL dialect used in the project "superbol.cobol.dialect" for a documentation on
every available dialect). In SuperBOL, the default dialect corresponds to GnuCOBOL’s default,
that supports many features from dialects such as COBOL2014, IBM, MicroFocus (mf), or GCOS for
instance;
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4.3 Syntax diagnostics
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[!NOTE]

Syntax checks performed by SuperBOL Studio currently cover the COBOL85 dialect, and some
constructions of more recent dialects supported by GnuCOBOL. Reporting of such diagnos-
tics is currently disabled for dialects other than COBOL85 to avoid misleading developers with
false diagnostics about syntax errors.

Reporting can be re-enabled for every dialect by setting the Force Syntax Diagnostics flag
in SuperBOL configuration settings.

4.4 Collaborating with other developers
At this point, the settings for your project are stored and managed by VS Code. However, you may
plan to collaborate with developers that do not use this editor. For instance, they might want to
use our mode for GNU/Emacs, which is located here. Then, we advise you to let SuperBOL Studio
store the configuration in a superbol.toml file that will be located at the root of the project.

You can make the extension write your current project configuration into a superbol.toml by
entering the command palette (View > Command Palette…, or press Ctrl+Shift+P), and then
selecting the command SuperBOL: Write Project Configuration.

Figure 4:  SuperBOL: Write Project Configuration

This will save a superbol.toml file at the root of each currently opened project directory. Such a
file will not store any user-specific settings, so you can now safely put them under source control.
Extensions dedicated to the edition of TOML files, such as tamasfe.even-better-toml, provide
the same level of assistance as when you edit .vscode/settings.json.

[!TIP]

Install the OCamlPro.SuperBOL-studio-pack extension to get SuperBOL Studio and
tamasfe.even-better-toml altogether.
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Figure 5:  Editing superbol.toml

5 Navigation Features
5.1 Outline & Breadcrumbs
SuperBOL provides an outline view of your program once you open it, that you can use to navigate
to specific sections or symbols (data items, paragraphs, etc). The same information is also shown
in the “breadcrumbs” bar, that is usually located above the text edition area.

17

https://code.visualstudio.com/docs/editor/editingevolved#_breadcrumbs


Figure 6:  Outline & Breadcrumb

5.2 Go to Symbol
Symbols shown in Outline and Breadcrumbs views can also be searched and jumped to by pressing
Ctrl+Shift+O.

Figure 7:  Go to Symbol
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5.3 Go to Definition
When you want to locate the definition of a data item name in your source code, position your
cursor on its name, right click, and select  Go to Definition (or press F12).

Figure 8:  Go to Definition

[!NOTE] (Temporary limitation)

At the moment, definitions that belong to communication, report, or screen sections of the
data division are ignored by the extension. In addition, some definitions in embedded SQL
blocks (EXEC SQL) are not taken into account yet.

5.4 Peek Definition
To only have a peek at where such a data item defined, you can position the cursor on its name,
right click, and select   Peek > Peek Definition (or press Ctrl+Shift+F10). You will then be
presented with a view of the location of the corresponding definition, including if it lies in a
copybook.
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Figure 9:  Peek Definition in copybook

5.5 Go to References
If you want to obtain a list of all references to a named data item, right click and select  Go to
References (or press Shift+F12). You will then view the location of every reference to this item.

Figure 10:  Go to References

[!NOTE] (Temporary limitation)
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Limitations mentioned in Go to Definition also apply.

5.6 Reference Information
The extension shows inline reference information above definitons of data items and elements of
the procedure division.
The same limitations as for Go to Definition apply.

Figure 11:  Reference Information

[!TIP]

This feature can be turned on or off by tuning the "editor.codeLens" configuration setting
(you can type Ctrl+, and then codelens to change this setting).

5.7 Hover to Show Copybooks
Ever wondered what was behind a COPY directive? Just position your cursor over such a statement,
and you will be presented with the contents of the copybook.
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Figure 12:  Hover over COPY

To ensure this works correctly, check your "superbol.cobol.copybooks" and
"superbol.cobol.copyexts" settings.

5.8 Hover to Show Source Text Replacements
What’s more? You can see the source text that results from replacement by a REPLACE directive
in the same way.

Figure 13:  Hover over replacement
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6 Edition Features
6.1 IntelliSense (auto-completion)
When editing a program, you can press Ctrl+Space to obtain suggestions on valid keywords, user-
defined words (data item or paragraph names), and even complete COBOL sentences. Select an
option with the arrow keys, and press Enter to insert the selected suggestion.
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(Temporary limitation)

Suggestions of user-defined words may not comprise symbols that are defined in the communi-
cation, report, or screen section of the data division. Although user-defined words that occur in
configured copybooks are also suggested, preprocessor-related variables or phrases are not.

6.2 Rename Data Items, Sections, and Paragraphs
You can rename any data item by pressing F2 while your cursor is positioned on one of its
references. The extension will warn you if a reference to the renamed item appears in a copybook
(in which case the renaming of every reference is not performed).
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Figure 14:  Rename Symbol

Figure 15:  Rename Symbol in Copybook

Sections and paragraphs of the procedure division can also be renamed in the same way.
The same limitations as for Go to References apply to this feature.
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7 Control-Flow Visualization
7.1 Exploring the Control-flow
Navigating a graphical representation of a COBOL program’s control-flow proves invaluable
when it comes to decipher its overall logic. To do this, open the command palette (or type
Ctrl+Shift+P), and select SuperBOL: Show Control-flow (you can also right click and select Show
Control-flow in the menu). You are then presented with a list of portions of program to consider
(either the entire program, or individiual sections): select one element to see the corresponding
CFG.

Figure 16:  CFG Explorer

Various settings are provided to tune the rendering of CFGs.
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Figure 17:  CFG Explorer Collapse Fallthrough

7.2 CFG as an arc diagram
A rendering of CFGs as arc diagrams is also available. In this representation, named sections and
paragraphs are laid out vertically, and arcs show the direction of control-flow between them.

Figure 18:  CFG Explorer as Arc Diagram
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8 Debugging Programs
8.1 Debugging
In order to debug a COBOL program, you first need to run a build task with appropriate debug
options. Once this is done, you can launch the compiled program in a debugging session.

[!NOTE]

We recommend that a version of GnuCOBOL that is at least as recent as version 3.2 be
available on the system running VS Code. Debug and coverage features respectively assume
that gdb and gcov are installed.

On Windows systems, users may employ dedicated installers that are available here. Linux
users may rely on their favorite package manager and install gnucobol.

8.2 Running a Build Task for Debugging
After having opened the program to debug, select Terminal > Run Build Task… (Ctrl+Shift+B),
and then SuperBOL: build (debug).

Figure 19:  Select SuperBOL: build (debug)

8.3 Launching the Compiled Program for Debugging
If needed, you can place a breakpoint on statements (or paragraph titles in the procedure division)
by clicking on the red dot that appears when you hover the cursor on the left margin (or with
F9). Click on the red dot or press F9 again to remove a breakpoint. Then, to launch the program
in debug mode, select Run > Start Debugging (F5). This will run your program until a first
breakpoint if reached, or to completion.
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Figure 20:  Start Debugging

Once stopped on a breakpoint, you can investigate the values of data items from the program
using the VARIABLES panel on the left-hand side.

Press F10 to step to the next statement, or F5 again to continue until the next breakpoint, or
termination of the program.

8.4 Customizing Build Tasks
To customize a build task, you can select Terminal > Configure Default Build Task…, and then
SuperBOL: build or SuperBOL: build (debug) (the latter being the task that is run whenever
you start a debugging session, e.g with F5).

Save the tasks.json as shown. Definitions for this task notably include a forDebug flag, that
instructs the compiler to insert debug annotations into generated executable files (this effectively
passes flags -ftraceall and -g to cobc). The extraArgs setting can be edited to pass additional
arguments to cobc.
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Figure 21:  tasks.json for debug

9 Code Coverage
GnuCOBOL can instrument your programs so they can generate coverage information at runtime.
To enable this feature, you can set the forCoverage setting to true in the Superbol: build
(debug) task in your tasks.json file. This flag instructs the extension to pass the --coverage
flag to the cobc compiler.

9.1 Coverage Information
Generated coverage files are in gcov format; they are portable, and you can use them as you would
any other coverage file generated for programs written using other programming languages.

9.2 Highlighting Coverage Information
Coverage data can be shown after the execution of a program that was compiled to generate this
information terminates. SuperBOL will display coverage on a line-by-line basis, by highlighting
the lines of your source code using colors that represent their coverage status. To enable coverage
highlighting, you can open the command palette (or type Ctrl+Shift+P), and select SuperBOL:
Show Coverage. You can also hide the highlighting with the command SuperBOL: Hide Coverage,
and update it after re-executing your program with SuperBOL: Update Coverage.

30

https://gcc.gnu.org/onlinedocs/gcc/Gcov-Intro.html
https://gcc.gnu.org/onlinedocs/gcc/Gcov-Intro.html


Figure 22:  Show Coverage

10 Using Vscode in General
10.1 Navigating through Warnings and Errors aka Problems
Problems (errors and warnings) are not always as visible as we would want. You should probably
install an extension to improve their display, typically the “Error Lens” VSCode extension) that
displays errors as inline messages in the source code.

You can also use the following shortcuts:

• Ctrl+Shift+M: go to the first problem, and display the “Problems” tab, showing the list of all
problems found. You can use arrow keys to navigate the problems.

• F8: go to next problem in file

• Shift+F8: go to previous problem in file

Some users like to use other shortcuts, for example because F8 is already used for something else.

For that:

• Open the “Keyboard Shortcuts” by typing successively Ctrl+K Ctrl+S

• Type “Problem” to display related shortcuts

• Click on the shortcut you want to edit, and use “Change Keybinding” to propose a new binding

• For example, in our case, we will use Alt+N for “Go to Next Problem in Files”
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10.2 Switching between Light and Dark Themes
1. Open the Command Palette with CTRL + SHIFT + P
2. Type “Color Theme”.
3. Select Preferences: Color Theme from the dropdown.
4. Choose a color theme, typically the Dark modern or Light modern.

Figure 23:  Color Theme Dropdown
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Figure 24:  Color Theme Dropdown

10.3 The “Do you trust the authors” popup
When entering a new project, you always get the following popup:

Figure 25:  Do you trust popup

To use SuperBOL Studio extension, you need to reply “Yes, I trust the authors”.

If you reply “No, I don’t trust the authors”, Vscode enters a Restricted Mode, where:

• Extensions are disabled: Most extensions that actually do things (like debuggers, linters, or
language servers for Python/C++) will be turned off. This prevents a malicious workspace from
using an extension to run a script in the background.
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• Tasks are blocked: Any automation you’ve set up in .vscode/tasks.json (like your make
command for Pandoc) will be disabled. VS Code won’t run them because it doesn’t know if the
command is safe.

• Debugging is disabled: You cannot launch the debugger, as this requires executing the code in
the workspace.

• Workspace Settings are ignored: Some settings defined specifically for that folder (in .vscode/
settings.json) will be overridden by your global user settings to prevent the folder from
“hijacking” your editor’s behavior.

If you replied “No”, you will see a “Restricted Mode” button in the bottom left corner, click on it
and select the “Trust” box to change it.

Figure 26:  Color Theme Dropdown

11 SuperBOL Studio Reference
11.1 SuperBOL Studio Configuration
There are several configuration files used by VSCode:

• By default, options are taken from the user configuration in $HOME/.config/Code/User/
settings.json (on Linux)

• In a workspace, options are taken from the workspace configuration in .vscode/settings.json

• Additionnally, SuperBOL Studio LSP server will also use options from superbol.toml at the
root of the workspace, as a preference over options from settings.json files. This file is also
used by other tools from SuperBOL that are not related to VSCode.

The command SuperBOL: Write Project Configuration can be used to export the configuration
from the settings.json to the superbol.toml file.

11.2 SuperBOL options in settings.json
• superbol.cobol.dialect (string, default: default): Default COBOL dialect for all files
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The available dialects are:

‣ default and gnucobol: a global dialect including all other dialects

‣ cobol85: only keywords from ANSI COBOL 85

‣ cobol2002: only keywords from COBOL ISO 2002

‣ cobol2014: only keywords from COBOL ISO 2014

‣ acu and acu-strict: the ACUCOBOL-GT dialect

‣ bs2000 and bs2000-strict: dialect for Fujitsu’s COBOL2000 V1.5 compiler

‣ gcos and gcos-strict: dialect for COBOL on BULL GCOS mainframes

‣ ibm and ibm-strict: dialect for COBOL on z/OS IBM mainframes

‣ mf and mf-strict: dialect for Visual COBOL by MicroFocus (RocketSoftware now)

‣ mvs and mvs-strict: dialect for IBM COBOL for MVS & VM

‣ realia and realia-strict: dialect for CA Realia II

‣ rm and rm-strict: dialect for RM-COBOL

‣ xopen: dialect for X/Open COBOL

The -strict version of a dialect permits using reserved words from all other dialects as custom
COBOL words, as the non-strict version also reserve these words.

You may also specify an absolute path to a custom GnuCOBOL dialect configuration file (see
cobc’s -conf option).

(May be overriden in project-specific superbol.toml files)

• superbol.cobol.sourceFormat (string, default: auto): Default source reference-format.

The available formats are:

‣ auto: SuperBOL will try to discover the format by automatically

‣ fixed: the old format, with a non-significant left margin of 6 characters, an indicator (* for
comments) and a non-significant right margin after column 72

‣ cobol85: same as fixed, but with strict verification of Area A.

‣ variable: Same as fixed, but non-significant right margin starts after column 252

‣ xcard: ICOBOL xCard format. Same as fixed, but non-significant right margin starts after
column 255.

‣ free: the new free format, with no margins and limitations. Comments are introduced by *>
(except in MicroFocus dialect, where a * should be put in column 1)

‣ xopen: X/Open Free format. Text starts at column 1, unless an indicator is present (* for
comments, D for debug), and lines of up to 80 characters.
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‣ crt: ICOBOL Free-form format. Same as xopen, but with lines of up to 320 characters.

‣ terminal: ACUCOBOL-GT Terminal format. Same as crt. Mostly compatible with VAX
COBOL terminal format.

‣ cobolx: Indicator in column 1, text starts at column 2, and ends at column 255.

(May be overriden in project-specific superbol.toml files)

• superbol.cobol.copybooks (array, default: [ { "dir: "." }]): Copybook Paths. Each object
in the path contains at least a directory in the dir field, and a file-relative field (default
it true).

(May be overriden in project-specific superbol.toml files)

• superbol.cobol.copyexts (array, default: ["cpy","cbl","cob"]): File extensions for copybook
resolution

(May be overriden in project-specific superbol.toml files)

• superbol.cobcPath (string, default: “cobc”): GnuCOBOL Compiler Executable: Path to the
GnuCOBOL compiler executable

• superbol.lspPath (string, default: ““): SuperBOL Executable

Name of the superbol-free executable if available in PATH; may be an absolute path otherwise.
Leave empty to use the bundled superbol-free, if available.

• superbol.forceSyntaxDiagnostics (boolean, default: false): Force reporting of syntax diag-
nostics for dialects other than COBOL85

• superbol.cacheInGlobalStorage (boolean, default: false): Use storage provided by Visual
Studio Code for caching. When this setting is set to false, the cache related to the contents of a
given workspace folder f is stored in a file named f/_superbol/lsp-cache.: cache files are not
removed automatically, whatever their location.

• superbol.debugger.displayVariableAttributes (boolean, default: false): Display Variable At-
tributes

Display storage property and field attributes (e.g.  size of alphanumerics, digits and scale of
numerics).

• superbol.debugger.libcobPath (string, default: null): GnuCOBOL Runtime Library

Path to the GnuCOBOL runtime library file

• superbol.debugger.gdbPath (string, default: “gdb”): GNU Debugger Executable

Path to the GNU debugger executable.

• superbol.debugger.cobcrunPath (string, default: “cobcrun”): GnuCOBOL module loader

Path to cobcrun, the GnuCOBOL module loader.
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11.3 SuperBOL Options in superbol.toml
Not all options from settings.json can be set in superbol.toml. The following options can be
set, in the [cobol] section of the TOML file:

• dialect: Default dialect for COBOL source files
• source-format: Default source reference-format
• copybooks: Where to find copybooks
• copyexts: Copybook filename extensions (for example ["cpy", "cob"])

11.4 SuperBOL Commands
• SuperBOL: Restart Language Server:

• SuperBOL: Write Project Configuration: translate options from the settings.json file to
the superbol.toml file.

• SuperBOL: Show Coverage:

• SuperBOL: Hide Coverage:

• SuperBOL: Update Coverage:

• SuperBOL: Show Control-flow:

• SuperBOL: Show Control-flow as an Arc-diagram:

12 Troobleshouting
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